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Chapter 8: TROUBLESHOOTING

Everyone has problems on occasion. Fortunately, most problems 

have occurred before and we have answers for them. Below are some 

of the most common confusions and issues you may run into when 

running RealPlayer. If you still have unanswered questions, please 

visit http://service.real.com for the most up-to-date information. (See 

also Help with Using RealPlayer on page 7.)

Video/Display Problems

How do I get Full Screen to work?

For Windows

If you are having problems with Full Screen (e.g., only a black screen appears), 

make sure that you have the following installed on your machine:

Microsoft DirectX with DirectDraw (v5.0 or later)

You can access the most recent version and installation instructions from 

RealNetworks� DirectDraw Support page:

http://service.real.com/fullscreen/

When you install DirectX, you must choose to upgrade your video drivers. 

Updated video drivers

You can usually find the latest drivers on the website of the company that 

manufactured your video card. By upgrading your video drivers you may lose 

some functionality provided by your old drivers. Your video card manufacturer 

is solely responsible for the scope of these functions.

As a convenience we offer links to some of the most common video card  

manufacturers on the RealNetworks' video driver support page:

http://service.real.com/fullscreen/driverlink.html
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For Macintosh

If Full Screen does not seem to be working, try selecting Full Screen from the 

Zoom control after you have connected to the clip you wish to view.

How do I exit Full Screen mode?

Use the ESC key (Escape key) on your keyboard to exit Full Screen mode in 

Windows or press any key to exit Full Screen on a Macintosh.

Why is my video playback ugly?

RealPlayer attempts to show video at whatever color depth your system is set 

to display. If the color settings in your Control Panel are set  less than 16-bit, 

(see System Requirements on page 3) you will get poor or no results when 

viewing video clips. You should increase your screen resolution to 16-bit 

(thousands) or 24-bit (millions) color.

To change your  color depth in Windows

1. Choose Settings/Control Panel from your Start button.

2. Double-click Display.

3. Click the Settings tab.

4. Change the Color palette setting to High Color (16-bit) or True Color (24-

bit).

Warning

You may not be able to go to a higher color setting 

depending on the desktop area you have selected and 

your video card. Windows will only allow you to select 

choices that are appropriate for the installed video 

driver.

5. Click Apply. You may have to reboot your computer to have the changes 

take effect; Windows will inform you if you do.

Additional Information

Avoid using Zoom (see Display panel on page 14) if you 

do not have a high bandwidth connection or very good 

connection.
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To change your color depth on Macintosh

1. From the Apple Menu, select Control Panels.

2. Open the Monitors & Sound control panel.

3. Change Color Depth to Thousands or Millions.

4. Change Resolution to 800x600 or better.

Why is my video distorted or not displaying at all [Windows]?

To deliver the best video in the fastest way possible, RealPlayer uses the latest 

optimized video protocols. Not all video cards or their drivers will function 

properly with this optimized approach. If a video card or its drivers are 

incompatible you may see unexpected results (see The Symptoms immediately 

below). 

The Symptoms

Incompatibility with optimized video usually manifests itself in one of the 

following ways:

1. You do not see any video in your RealPlayer Display panel. All you see is an 

empty, magenta square.

2. You do not see any video in your RealPlayer, only a snowy picture that 

moves. (Go to Turn off Optimized Video on page 78.)

3. You see video in your RealPlayer but it has a green tint to it and may be 

distorted so that you only see stripes of the video or only part of an 

enlarged picture. The overall effect is as if you were looking through a hole 

at a larger screen. 

4. You see video in your RealPlayer but it is stretched vertically or 

horizontally in only one direction. The picture distorts into a wide, flat 

picture or a tall, thin one.

5. You see video, but it is more like a slide show than moving pictures and/or 

the edges are ragged and pixelated (looks like it is made up of a bunch of 

blocks rather than a clear picture).

If you are experiencing one, or more, of these symptoms, confirm the problem 

by using the test below to be sure that optimized video is the issue and not 

some other conflict.
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Confirming the Problem

If you are seeing any or all of the above symptoms, do the following to make 

sure it is an optimized video issue:

1. Connect to a video clip or click Play to start playing a loaded video clip.

2. Wait until the video is exhibiting one of the above symptoms.

3. Click and hold on the title bar of your RealPlayer (the blue bar on the top 

of the Player).

4. Drag your RealPlayer to a new location on your desktop.

If you saw the video playing properly while you were dragging your RealPlayer 

but the problems reappeared when you stopped dragging your RealPlayer (or 

shortly after you stopped dragging it):

Turn off  Optimized Video

1. Select View/Preferences... from your menus.

2. Go to the Performance tab (see Performance Preferences on page 71).

3. Find Video card compatibility at the bottom of the tab.

4. Deselect (uncheck) Use optimized video display.

5. Click OK.

6. Close RealPlayer and restart it. (If you have StartCenter running, you will 

need to close this as well to fully restart RealPlayer. To close StartCenter, 

right-click on the StartCenter icon and select Close StartCenter. StartCenter 

will restart when you launch your Player again).

7. Attempt to play the video again.

If you still do not see the video playing properly, then other issues may be 

affecting your RealPlayer. Contact Technical Support at 

http://service.real.com for access to the RealPlayer Frequently Asked 

Questions (FAQ) and other up-to-date and technical information.

If you update or change your video driver or video card, you should reselect 

Use optimized video display to see if it works properly. If it does not, follow the 

instructions above again to solve the conflict.
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Why is my video showing in my menus [Macintosh]?

If video appears in your menus while you are using RealPlayer, for instance 

when you open a module or drop-down menu over RealPlayer and rather than 

seeing the menu, you see video in the square, there are two solutions.

1. Move RealPlayer more toward the center of your screen or away from any 

menus.

2. Turn off Optimized video (described below). Turning off optimized video 

will slow the performance of RealPlayer.

a. Select View/Preferences... from your menus.

b. Go to the Performance tab (see Performance Preferences on page 71).

c. Find Video card compatibility at the bottom of the tab.

d. Uncheck Use optimized video display.

e. Click OK.

f. Close any current clips.

g. Attempt to play the video again.

Audio Problems

Why is my audio playback poor?

Playback quality varies depending on available bandwidth and how the file 

you are playing was encoded. If the quality is garbled, choppy, or skipping, use 

the following guidelines to isolate and correct the problem. 

If the quality was poor when firstrun_plus.smi or Welcome.smi file played at 

the end of the RealPlayer installation, you could have a sound card conflict. 

Try changing the settings on the Performance tab (see Performance 

Preferences on page 71).

If the quality was good when the firstrun_plus.smi or Welcome.smi file played 

at the end of the RealPlayer installation, but is bad when you try to play a clip 

from a web, use the View/Statistics to check for lost packets (see your  

RealPlayer Help file for more information on the Statistics pane). If the packet 

loss is high, it may be due to a busy network. If this is the case you should also 

see the net health indicator blinking yellow or red on your Status bar. 

RealPlayer users can select PerfectPlay Mode from the Play menu and try to 

play the clip again or connect to the site at a later time.
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If the quality was good when the firstrun_plus.smi or Welcome.smi file played 

at the end of the RealPlayer installation, but sounds bad for every clip that you 

try to play on the Internet, complete the following steps.

If the playback quality is poor on every site:

1. Check the actual modem connection speed. This speed may be shown in 

the lighted display for external modems or through an information 

window if you have an internal modem (check the user manual for your 

modem). Sometimes service providers use a lower rate connection speed 

such as 28.8Kbps, so, even though you are dialing in to your ISP on a 

56Kbps modem, you are only receiving data at 28.8Kbps. 

2. If your computer seems sluggish during playback, try adjusting your 

playback performance. On the Performance tab of your Preferences, adjust 

the Playback Performance slider closer to Lowest CPU usage.

3. If audio on every site is scratchy, popping, or distorted, click Settings... in 

the Sound card compatibility section of the Performance tab and choose 

Disable 16-bit audio. (Windows only)

4. If you are getting no audio or audio is playing back quickly (everything 

sounds like a chipmunk), click Settings... in the Sound card compatibility 

section of the Performance tab and choose Disable custom sampling rate.

5. If you are using an external modem with a Windows PC and the Statistics 

window shows minimal packet loss (10% or less), your system may have a 

problem with the speed at which packets are transferred between the 

modem and your computer. Try setting the port speed higher (at least 

twice the modem speed).

6. Contact RealNetworks' Technical Support at http://service.real.com

Why doesn't my RealPlayer have a Volume Control?

In Compact Mode the Volume Slider changes to a pop-up control.

Click to pop-up the volume slider. When you click off of the slider, it will 

disappear again, but your setting will remain active.

The Mute button is available next to the volume control once you open it as 

described above.
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Why can�t I hear anything?

RealPlayer uses the Wave interface for Windows to get the sound out to your 

speaker. In some cases this may have been accidentally turned off by other 

programs or users.

The Wave interface Volume Control

In the Windows system tray (the area that shows you the date and time 

opposite the Start button) you may see a Volume Control (a small icon that  

looks like a speaker). Double-click on the icon to open the control applet.

Make sure that the Wave slider is not muted and is set above zero and that the 

Master Control is turned On.

Connection Problems

Why can't I play clips on my computer at work? 

If you're on a local area network which is attached to the Internet, and are  

unable to play RealMedia files from remote web sites, it's possible that your 

company's firewall is preventing the stream from reaching you. Users can 

receive live and on-demand audio and video from the Internet without 

exposing their company's network to security risks.

If your computer is behind a firewall, please see RealNetworks' firewall page  

for more information: http://service.real.com/firewall/

Why does RealPlayer use the wrong ISP?

When attempting to connect automatically to the Internet, RealPlayer will 

select your default Internet connection. If you have more than one Internet 

Service Provider (ISP), RealPlayer may be selecting the wrong one.

To change your default ISP in Windows95

1. Choose Settings/Control Panel from your Start button.

2. Double-click Internet.

3. Click the Connection tab. (Some browsers have this on the Settings tab.)

4. Change the Dial-up Connection setting to your preferred ISP.

5. Click Apply.
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Note

Windows98; re-run the Internet Connection Wizard.

To change your default ISP on Macintosh

1. Open the Remote Access control panel from the Apple Menu.

2. Select Configurations.

3. Choose the appropriate ISP.

4. Click Make Active.

5. Click Done.

6. Open the TCP/IP control panel from the Apple Menu.

7. Enter the appropriate information for the ISP.

8. Click Done.

Am I behind a Firewall? Do I need to use Proxy?

If you are behind a firewall you may consistently have one of the following  

problems:

You are accessing the Internet via an Internet Service Provider or a cable 

modem and have trouble connecting to RealAudio or RealVideo files on some 

or all Web sites but you can play local .RM or .RA files such as videotest.rm, 

which was copied to your RealPlayer directory when RealPlayer was installed 

(c:\Program Files\Real\RealPlayer by default, Windows only). 

1. You are on a local area network which is attached to the Internet, and are 

unable to play RealAudio and RealVideo files from some or all remote 

Web sites but you can play local .RM or .RA files such as videotest.rm, 

which was copied to your RealPlayer directory when RealPlayer was 

installed (c:\Program Files\Real\RealPlayer by default). 

2. You receive one of the following errors consistently while trying to play 

content: 

Error 18: Invalid socket error

Error 22: Requested server is not valid

Error 108: Invalid Auto Transport Configuration Setup

If you are still unsure about whether or not you are behind a firewall, contact 

the Systems Administrator for your ISP or your company. 

First attempt to Auto-configure your transport settings:
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1. From the File Menu, Select View/Preferences. 

2. Select the Transport tab. 

3. Make sure the dot in front of Automatically Select Most Efficient Transport 

is selected. 

4. Click Auto-Configure... 

5. The Auto Transport Configuration box should come up.

6. Click OK. 

7. As soon as the configuration is done, the message, Auto Transport 

Configuration is complete will appear in the box. 

8. Click OK. 

Attempt to play a clip on the Internet. 

If this does not help, you may try to manually configure the Player for the 

firewall. The RealPlayer can be configured to receive RealAudio/RealVideo 

through several different transport methods in order to accommodate 

firewalls. These transport methods include:

� UDP on a single port

� TCP-only

� HTTP-only

The UDP option may offer better sound quality than TCP, so TCP-only may 

not be desirable. The RealPlayer also offers the ability to limit those inside a 

firewall to receiving UDP on only one port, which makes router configuration 

easier. Please contact your System Administrator for the Port number they have 

configured for UDP transmission. 

To configure the RealPlayer to receive UDP through a single port

1. In your RealPlayer, select Preferences on the View menu. 

2. Click the Transport tab. 

3. Click Use Specific UDP Port and enter the UDP port number through 

which you want to receive the UDP streams. 

4. Click OK to save your changes.

To configure the RealPlayer to use only  TCP to stream audio or video (no UDP) 

1. In your RealPlayer, select Preferences on the View menu. 
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2. Click the Transport tab. 

3. Select Use Specified Transports.

4. Click RTSP Settings... and/or PNA Settings... Each transport is set 

separately.

5. Choose Use TCP to Connect to Server. Make sure that the Attempt to Use 

TCP for All Content box is the only one checked. 

6. When you are finished, click OK. 

7. Click OK in the Preferences window to save your changes.

To configure the RealPlayer to use receive content through HTTP-only 

The HTTP-only option allows almost all Players behind a firewall to access 

RealAudio and RealVideo content. 

1. In your RealPlayer, select Preferences from the View menu. 

2. Click the Transports tab. 

3. Select Use Specified Transports. 

4. Click RTSP Settings... and/or PNA Settings... Each transport is set 

separately. 

5. Click Use HTTP Only at the bottom of the dialog. 

6. Click OK. 

7. Click OK in the Preferences window to save your changes. 

Additional Information

For more information on firewalls, please see the 

following URL: http://www.real.com/firewall/

In some cases you may need to set a proxy so your RealPlayer can receive 

information. In most cases, Use my web browser�s HTTP proxy (see HTTP 

Options in Proxy Preferences on page 69) will work. However, depending on 

the firewall protecting your connection to the Internet this may not be 

enough. Please contact the System Administrator for the correct address and 

Port numbers for your network. Incorrect information can cause your RealPlayer 

to appear to not work.
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Other Problems

How can I stop RealPlayer from loading on start-up [Windows only]?

When RealPlayer is installed it adds a shortcut icon in your system tray (the 

area that shows you the date and time opposite the Start button). The icon 

keeps RealPlayer in idle mode so that it is quickly available should you click on 

a file that requires RealPlayer and allows your Channel Headlines to 

automatically update while you maintain a connection to the Internet. 

Additionally this icon allows you to function on clips that are currently 

playing even if RealPlayer is minimized. To see these functions, right-click the 

RealPlayer icon in your system tray.

If you wish you remove the icon from your system tray:

1. Right-click the icon.

2. Select Close StartCenter. Closing StartCenter will only disable the feature 

for the current Windows session. StartCenter will load RealPlayer the next 

time you reboot Windows.

To stop RealPlayer from loading when you start Windows:

1. Select View/Preferences... from your RealPlayer menus.

2. Click the General tab.

3. Click Settings... in the StartCenter section.

4. Uncheck Enable StartCenter.

5. Click Yes to verify that you want to disable StartCenter.

6. Click OK to confirm the changes.

What types of files can RealPlayer play?

RealPlayer plays a wider variety of media, both locally and over the Internet, 

than earlier versions. The chart below highlights most of the current file-types 

that can be played.  Plug-ins to play many other file types, such as QT2, MOV, 

and ASF, are available and new plug-ins are being added all the time to expand 

RealPlayer�s abilities for you. 

If you click on a file that RealPlayer can't currently play, it will attempt to 

AutoUpdate and install a plug-in to match, or you can check  with 

RealNetworks to see if a plug-in exists. If a plug-in exists, RealPlayer can 
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download and install it so you will be able to play the file (see Upgrade 

Preferences on page 63 and AutoUpdate in your RealPlayer Help).

Additional Information

In order to make video feasible on the computer, video 

compression algorithms are used to remove redundant 

audio and video data.  The codec (COmpressor / 

DECompressor) is the algorithm that does the 

compression and decompression.  Operating Systems 

come with standard codecs (example, Apple QuickTime 

or Microsoft Video for Windows) installed.  If a file is 

created with a non-standard codec, the matching codec 

must be installed on the computer before the file can be 

played.  The codec may be installed as a RealPlayer plug-

in, or it may be installed directly to the operating 

system.
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To see which components you currently have installed

1. Select View/Preferences...

2. Click the Upgrade tab.

3. To see the currently installed plug-ins, click Settings... in the RealPlayer 

Plug-ins section of the tab. You can remove a plug-in by highlighting it 

and clicking Remove.

*When you play this file type with RealPlayer, you may receive an error such
as, “Unable to render” or “xxxx decompressor not found” or “Missing codec
xxxx.” These errors occure because the file was created with a codec that is
not installed on your computer.  You need to download and install the neces-
sary codec to play these files.

When first setup, RealPlayer can play the following file types:

File Extension: File-type:

RM, RA, RAM RealAudio/RealVideo streamed 
content

RT RealText streamed text formats

RP RealPix streamed PNG, GIF and 
JPG (�j-peg�) images

PNG, GIF, JPG Stand alone PNG, JPG and GIF 
images and animated GIFs

MP3 MPEG Layer 3 (audio format)

SWF RealSystem G2 with Flash

SMIL, SMI SMIL files (see SMIL on page 52)

WAV, AIFF* 'Legacy' sound files�older but 
prevalent filetypes.  (Not fully 
supported.)

MPG, MPEG Standard MPEG Layer 1 video and 
Layer 2 audio formats

AVI* Audio/Video Interleave�Microsoft 
video format

ASF* NetShow files (newer NetShow 
files may not play correctly)

MID, MIDI, RMI 'MIDI' sound files


